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About this document

 

This quick reference guide summarizes the tasks you perform when 
provisioning an AccessNode system. 

 

Who should use this guide

 

It is intended for personnel who are familiar with AccessNode equipment and 
its interfaces. 

 

How this guide is organized

 

The procedures in this guide are grouped according to the tasks you must 
perform when provisioning the system. The tasks, and the procedures within 
each task, appear in the order in which they are to be performed as shown on 
page 3.
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AccessNode provisioning 1-

 

Provisioning overview

 

“Provisioning task list” on page 3 lists in sequence the tasks you must perform 
to provision different configurations of AccessNode systems. To identify 
which procedures to perform, locate the column that matches your 
configuration and perform each procedure that has an “X” in that column.

The procedures contain the information required to perform each action, but 
without the level of detail found in the  AccessNode documentation suite. If 
you require additional information for a procedure, refer to the AccessNode 
document identified at the start of the task.

 

Note: 

 

If a procedure within a task appears in a different document, the 
last three digits of the document number are listed in parenthesis after the 
procedure title.

 

Prerequisites

 

To perform these procedures you will need:

• a VT100-compatible terminal or laptop computer with a VT100 
emulation package

• an OPC user ID and password that allow you access to the OPC 
Provisioning Manager tool

• the NE user ID and password for the admin security level, for each 
network element (NE) to be provisioned
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Group and slot associations

 

Many of the procedures in this guide require you to enter a circuit pack group 
number in a command string. The group number you enter depends on the 
type of common equipment shelf and the slot occupied by the circuit pack. 

 

Note: 

 

Refer to 

 

Mapper Layouts Planning Guide

 

, 323-3001-154, in the 

 

Engineering, Configuration, and Ordering Guide

 

, Volume 1 for 
engineering guidelines for your specific system type. 

Use “Group and slot associations” on page 8 to determine the group number 
that corresponds to a DS1, DS3, STS-1, OC-3, or OC-12 in an ABM or TBM 
common-equipment shelf. If you want to perform a procedure on all groups 
of the same type on a shelf, enter 

 

all

 

 in the command string.

 

Using the OPC UI

 

When performing provisioning functions at the OPC, use the arrow or Tab 
keys to move from field to field on the screen. Once the required field is 
highlighted, press Space or Keypad 0 to select it. 

To display the menu for a command in the main window, highlight the 
command and press Ctrl_L T (or Keypad,).

You can enter information in a field in one of three ways: 

• type directly in the field 

• press Ctrl_L / (or Keypad 3) to display the chooser menu associated with 
the field, move the cursor to the required entry, then press Ctrl_A (or 
Keypad 0) to select it

• press Ctrl_L (or Keypad Enter) to display the list item menu associated 
with the field, move the cursor to the required entry, then press Ctrl_A (or 
Keypad 0) to select it   

In the OPC procedures in this guide, the keystrokes required to perform 
provisioning functions are included (in brackets) only when they differ from 
the keystrokes listed here.

For detailed information on using the OPC UI and accessing the OPC tools, 
refer to 

 

OPC User Interface Description

 

, 323-3001-301, in 

 

Operations, 
Administration, and Provisioning

 

, Volume 4A.
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Provisioning task list 

 

Task Page 

Point-to-Point Ring 
node

DFA SE

 

Universal Integrated Combined

FCOT RFT FCOT RFT FCOT RFT FCOT RFT OPC RFT OPC RFT

 

Provisioning common equipment

 

Enabling or disabling equipment 
alarms

9 x x x x x x x x x x x x

Provisioning processor 
parameters

11 x x x x x x x x x x x x

Assigning the bay frame location 
ID

11 x x x x x x x x x x x x

Provisioning OC-3 or OC-12 
equipment performance 
monitoring thresholds

12 x x x x x x x x x

Assigning the shelf position 
number (TBM only)

13 x x

 

Provisioning protection switching

 

Provisioning DS1, DS3, or STS-1 
protection parameters

14 x x x x x x x x x x x

Provisioning OC-3 or OC-12 
protection parameters

15 x x x x x x x x x

Provisioning the OC-12 VTBM 
ring wait-to-restore period

15 x x

Scheduling a shelf event or 
exercise (302)

16 x x x x x x x x x x x x

Scheduling the exerciser for all 
ADMs in a ring

18 x x

Scheduling the exerciser for one 
ADM

19 x x

 

 (Sheet 1 of 5)
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Facility provisioning

 

Adding a facility to the system 20 x x x x x x x x x x

Enabling or disabling DS1 or 
STS-1 facility alarms

21 x x x x x x x x x x x

Enabling or disabling DS3, 
STS-1, OC-3, OC-12, or COMM 
facility alarms

22 x x x x x x x x x x x

Enabling or disabling TIC/STS-1 
and VT1.5 facility alarms

23 x x x x x x x x x

Provisioning DS1 facility 
parameters

26 x x x x x x x x x x x

Provisioning DS3 or STS-1 facility 
parameters

29 x x x x x x x x x x x

Provisioning OC-3 or OC-12 
facility parameters

31 x x x x x x x x x x x

Provisioning DS1, DS3, STS-1, 
OC-3, OC-12, VT path, or STS 
path facility performance 
monitoring thresholds

32 x x x x x x x x x x x

Provisioning SDCC connections 36 x x x x x x x x x

 

Synchronization

 

Enabling or disabling timing 
reference alarms

37 x x x x x

Provisioning ESI or TXC 
equipment alarm points

38 x x x x

Enabling or disabling ESI facility 
alarms

39 x x

Provisioning 
synchronization-status 
messaging

40 x x

 

Provisioning task list (Continued)

 

Task Page 

Point-to-Point Ring 
node

DFA SE

 

Universal Integrated Combined

FCOT RFT FCOT RFT FCOT RFT FCOT RFT OPC RFT OPC RFT

 

 (Sheet 2 of 5)
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Using the PSTN CI tool (for Hong Kong)

 

Selecting the Hong Kong PSTN 
load

46 x x x x x x

 

Host provisioning

 

Adding a new host to an RFT 48 x x x x x

Making a host the primary alarm 
host

48 x x x x x

 

Managing OC-12 VTBM rings

 

Scheduling an audit of 
configuration data

49 x x

Editing the APS ID for a ring ADM 51 x x

Sending configuration data to a 
ring ADM

52 x x

Editing the ring name 52 x x

 

Provisioning task list (Continued)

 

Task Page 

Point-to-Point Ring 
node

DFA SE

 

Universal Integrated Combined

FCOT RFT FCOT RFT FCOT RFT FCOT RFT OPC RFT OPC RFT

 

 (Sheet 3 of 5)
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Setting up connections at the OPC

 

Modifying the list of connections 53  x  x  x x

Finding available channels 57  x  x  x x

Finding available tributaries 55  x  x  x x

Adding an STS connection 58  x  x  x x

Adding a VT connection 59 x

Editing an STS connection 61  x x  x x

Editing a VT connection 62 x

Deleting an STS connection 66  x  x  x x

Deleting a VT-managed STS-1 
connection

67 x

Deleting a VT connection 69 x

Scheduling an audit of connection 
data

71 x

 

Provisioning line card services

 

Bulk-provisioning POTS service 
on a universal system

72 x  x

Bulk-provisioning services on a 
TR-08 shelf

73  x x  x x x

Adding a new universal circuit 74 x x

Adding a DS1 tandem, DS1 
tandem VT, TR-08, or TR-08 VT 
circuit

75 x x x x x x

Modifying circuit details 77 x x

Deleting a circuit 80 x x x x x x

 

Provisioning task list (Continued)

 

Task Page 

Point-to-Point Ring 
node

DFA SE

 

Universal Integrated Combined

FCOT RFT FCOT RFT FCOT RFT FCOT RFT OPC RFT OPC RFT

 

 (Sheet 4 of 5)
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Modifying log and alarm settings

 

Setting service-level logs and 
alarms

81 x x x x x x

Setting line card-level logs and 
alarms

83 x x x x x x

Enabling or disabling line card 
alarms

84 x x x x x x

Enabling or disabling ISDN 
alarms

86 x x x x x

 

Managing NE and OPC databases

 

Performing a manual NE 
database backup

87 x x x x x x x x x x x x

Saving OPC data to tape 88 x x x x x x

Scheduling an OPC backup 89 x x x x x x

 

Provisioning task list (Continued)

 

Task Page 

Point-to-Point Ring 
node

DFA SE

 

Universal Integrated Combined

FCOT RFT FCOT RFT FCOT RFT FCOT RFT OPC RFT OPC RFT

 

 (Sheet 5 of 5)
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*For DS3 TBM FCOT_BLSR fiber-fed shelves, this group is available only if no
  DS1s provisioned for that shelf. 

 

Group and slot associations

Mapper and
shelf function

Mapper slot

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

DS1

 

DS1-fed 
ABM 

G1 G2 P G4 G5 G6

ABM FCOT 
or 
FCOT_BLSR

G1 G2 P G4 G5 G6 G7 G8

TBM FCOT G3 G4 G5 G6 P G8 G9 G10 G11 G12

TBM 
FCOT_BLSR

G1 G2 G3 G4 G5 G6 P G8 G9 G10 G11 G12

TBM 
TN_BLSR 

G1 G2 G3 G4 G5 G6 G7 G8 G9 G10 G11 G12 P

 

DS3

 

ABM P S G1 G2 G3

TBM FCOT P S G1 - G3 G4

TBM 
FCOT_BLSR
or TN_BLSR 

P S G1

 

G2*

 

G3 G4

 

STS-1

 

TN_BLSR S P G1 G2 G4 G4

 

OC-3

 

ABM tributary G3 G4 G1S G2S

TBM tributary G3 G4 G1S G2S G5 G6 G7 G8

Feeder G1 G2

 

OC-12

 

Feeder G1 G2

OC-12 
VTBM

Feeder G1 G2
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Provisioning common equipment

 

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in 

 

Provisioning and Operations 
Procedures

 

, 323-3001-310, in 

 

Operations, Administration, and Provisioning

 

, 
Volume 4B. 

 

Enabling or disabling equipment alarms

 

Step Action

1

 

Login to the NE user interface. 

 

2

 

For circuit packs AIC, DS1, DS3, STS-1, OC-3, OC12, PROC, TIC, 
ESI, or TXC do substep a.

For circuit packs SH (shelf), IRTU, MIC, or TAC, do substep b.

For circuit packs CDSP, LIC, or MTAC, do substep c.

 

a.

 

Display the equipment alarm provisioning screen:

 

eq <type> <group>

 

; 

 

almprov 

 

↵

 

where
<type> aic, ds1, ds3, sts1, oc3,oc12, proc, tic, esi, or 

txc
<group> for DS1, DS3, STS-1, OC-3, or OC-12:

see “Group and slot associations” on page 8 
for ESI: g1 (top card) or g2 (bottom card)
for TXC: g1, or g2
for TIC, AIC, or PROC: a or b

Go to step 3.

 

b.

 

Display the equipment alarm provisioning screen:

 

eq <type>

 

; 

 

almprov 

 

↵

 

where
<type> irtu, mic, sh, or tac

Go to step 3.

 

—continued—
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Enabling or disabling equipment alarms (continued)

 

Step Action

c.

 

Display the equipment alarm provisioning screen:

 

eq> <type>; <details> <CDS#> <group>; almprov 

 

↵

 

where
<type> cdsp, lic, or mtac
<details> dtlcdsp, dtllic, or dtlmtac
<CDS # > copper distribution shelf: 1 to 7
<group> for LIC: a, b, c, or d

for MTAC or CDSP: a or b

 

3

 

Set the alarm points to either on or off:

 

editstat <alarm #> <status> 

 

↵

 

 

y

 

↵

 

where
<alarm # number of the alarm
<status> on or off

Repeat this step for each alarm point to be provisioned.

 

4

 

Repeat steps 2 and 3 for each piece of equipment to be provisioned.

 

- end -
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Step Action

1 Display the processor equipment screen:

eq proc <group> ↵

where
<group> processor unit: a or b

2 If required, toggle the data synchronization setting:

datasync ↵

3 If required, toggle the Rex test enable setting:

rexena ↵
- end -

Assigning the bay frame location ID

Step Action

1 Access the shelf equipment screen and select a shelf:

eq sh ↵

2 Access the edit shelf screen:

edit ↵

3 Assign the bay frame location ID:

location <location id>↵

where
<location id> up to 7 ASCII characters

Note: When typing the bay frame location ID, place it within single 
quotes (‘ID’); otherwise all the text converts to uppercase. Use single 
quotes if the ID includes spaces or special characters (?,=), or if the 
first character is a number.

- end -
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monitoring thresholds

Step Action

1 Display the performance monitoring screen:

pm↵

2 Display the equipment threshold provisioning screen:

eqpperf <type> <group>; threshld; edit ↵

where
<type> oc3 or oc12
<group> see “Group and slot associations” on page 8

3 Set the first threshold status for parameter one to on or off:

statust1 1 <status>↵

4 Provision the first threshold value for parameter one:

valuet1 1 <value>↵

where
<value> any positive integer

5 Provision the type of report to be generated when a threshold is 
crossed: 

rpttype <type>↵

where
<type>  alm or palrt

6 Repeat from step 2 for each OC-3 or OC-12 to be provisioned.

- end -
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Step Action

1 Access the shelf equipment screen and select a shelf:

equipmnt sh ↵

2 Access the edit shelf screen:

edit↵

3 Assign the shelf position number:

shpos <position #> ↵

where
<position #> 1 to 3 (The shelves are numbered from top to 

bottom.)

- end -
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Provision the same OC-3 and OC-12 protection parameters at both the central 
office NE and at each remote NE.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Protection Switching Procedures, 
323-3001-311, in Operations, Administration, and Provisioning, Volume 4B. 

Provisioning DS1, DS3, or STS-1 protection parameters

Step Action

1 Display the detailed protection screen:

pr; dtlprot <type>; protprov ↵

where
<type> ds1, ds3, or sts1

2 If required, provision the wait-to-restore period:

waittor <duration>↵

where
<duration>  200 or 300

3 If required, provision the priority level for protection:

priority <unit> <level>↵

where
<unit> see “Group and slot associations” on page 8
<level> low or high

Repeat this step for each DS1, DS3, or STS-1 group.

- end -
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Right oddProvisioning OC-3 or OC-12 protection parameters

Step Action

1 Display the detailed protection screen:

pr; dtlprot <type>; protprov ↵

where
<type> is oc3 or oc12

For oc3 or oc12, see “Group and slot 
associations” on page 8

2 Provision the switch mode:

swmode <mode>↵
y↵

where
<mode> uni or bi

3 For point-to-point (OC-12 or OC-3 feeder), set route diversity on or 
off:

routediv <status>↵

where
<status> on or off

- end -

Provisioning the OC-12 VTBM ring wait-to-restore period 

Step Action

1 Display the detailed protection screen:

protectn; dtlprot oc12; protprov ↵

2 Provision the wait-to-restore period:

waittor <# of minutes>↵

where
<# of minutes> 5, 6, 7, 8, 9, 10, 11, or 12

- end -
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Step Action

1 From the main menu level of the NE UI, access the system 
administration screen and display the NE profile parameters:

admin nep ↵

2 Access the edit schedule screen:

schedule;edit ↵

3 Specify how often the event or exercise is to run:

frequency <event #> <frequency> <unit>↵

where
<event #> for exerciser: 1; for backup: 2
<frequency> for day: 1 to 730

for hour: 1 to 17543
for minute: 60 to 32767
for second: 3600 to 32767

<unit> for day: d; for hour: h
for minute: m; for second: s

4 Specify the time the event or exercise is to start:

strttime <event #> <hour> <minute>↵

where
<event> for exerciser: 1; for backup: 2
<hour> 0 to 23; defaults to current hour
<minute> 0 to 59; defaults to 0

—continued—

If you are setting this parameter Then do

frequency step 3

strttime step 4

strtdate step 5

endtime step 6

enddate step 7
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Step Action

5 Specify the date the event or exercise is to start:

strtdate <event #> <day> <month> <year>↵

where
<event> for exerciser: 1; for backup: 2
<day> 1 to 31; defaults to current day
<month> 1 to 12; defaults to 1
<year> 1976 to 2039; defaults to 1976

6 Specify the time the event or exercise is to stop:

endtime <event #> <hour> <minute>↵

where
<event> for exerciser: 1; for backup: 2
<hour> 0 to 23; defaults to -, which means forever
<minute> 0 to 59; defaults to 0

To schedule the exerciser continually, do not enter an endtime. 
Instead press Return after specifying the event you want to schedule.

7 Specify the date the event or exercise is to stop:

enddate <event #> <day> <month> <year>↵

See step 5 for parameter values.
To schedule the exerciser continually, do not enter an enddate. 
Instead press Return after specifying the event you want to schedule.

- end -
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Step Action

This procedure is performed at the OPC. For a summary of the keystrokes 
required to navigate in an OPC screen, see “Using the OPC UI” on page 2.

1 Select the Network Summary tool from the Surveillance toolset. 

2 From the Network Summary main window, display the Protection 
option and select the required ring name.

3 From the list item menu for the Ring ADM, select Schedule 
exercisers. 

4 From the list item menu for the Ring ADM list, select Schedule all. 

5 Click OK to confirm that you want to set the schedule exercisers for 
all ADMs in the ring.

6 In the Start Time field, type the exerciser start time (hh:mm). 

7 In the Start date field, select either today or tomorrow from the 
chooser menu. 

To specify an end time and end date, do step 8.
To set the exerciser to run continuously, go to step 9.

8 In the End time and End date fields, type the required time (hh:mm) 
and date (dd/mm/yyyy).

Go to step 11.

9 In the “and repeat every” field, type how often the exerciser is to run. 
The value you type depends on the unit of frequency:

Days: 1 to 730 Hours: 1 to17543
Minutes: 60 to 32767 Seconds: 3600 to 32767

10 In the “and repeat every” unit field, select the unit from the chooser 
menu: Days, Hours, Minutes, or Seconds. 

11 Tab to the Offset buttons and select the desired offset time.

To specify an offset time other than the default time of 1 minute, select 
the appropriate button.

12 Select OK to update the information. 

13 Select Done twice to close the dialog and return to the Network 
Summary main window.

- end -
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Step Action

This procedure is performed at the OPC. For a summary of the keystrokes 
required to navigate in an OPC screen, see “Using the OPC UI” on page 2.

1 From the Network Summary main window, display the Protection 
menu and select the ring name.

2 In the Protection Details dialog, select Schedule exercisers from the 
list item menu for the Ring ADM.

3 In the Exerciser Schedule List dialog, select Edit Schedule from the 
list item menu for the required ADM.

4 In the Start Time field, type the exerciser start time (hh:mm). 

5 In the Start date field, select either today or tomorrow from the 
chooser menu.

To specify an end time and end date, do step 6. 
To set the exerciser to run continuously, go to step 7.

6 In the End time and End date fields, type the required time (hh:mm) 
and date (dd/mm/yyyy). Go to step 8.

7 In the “and repeat every” field, type how often the exerciser is to run.

The value you type depends on the unit of frequency:

Days: 1 to 730 Hours: 1 to17543
Minutes: 60 to 32767 Seconds: 3600 to 32767

In the “and repeat every” unit field, select the unit from the chooser 
menu: Days, Hours, Minutes, or Seconds. 

8 Select OK to update the information. 

9 Select Done twice to close the dialog and return to the Network 
Summary main window.

- end -
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Left even Facility provisioning
For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Adding a facility to the system

Step Action

1 Place the circuit pack in the slot if it is not already present. 

2 Display the screen for the facility to be added:
To add a DS1, DS3, or STS-1 facility, do substep a. 
To add an OC-3 or OC-12 facility, do substep b.

a. Display the DS1, DS3, or STS-1 facility screen:

fa <type> <group> <port>↵

where
<type> ds1, ds3, or sts1
<group> see “Group and slot associations” on page 8
<port> for DS1: 1 to 14; for DS3 or STS-1: 1 to 3

Go to step 4.

b. Display the OC-3 or OC-12 facility screen:

fa <type> <group>↵

where
<type> oc3 or oc12
<group> see “Group and slot associations” on page 8

3 Edit the facility provisioning options as necessary. (Refer to the 
procedures on provisioning facility parameters in this guide for more 
details.)

4 Add the new facility:

add ↵

5 For DS1, DS3, and STS-1 facilities, repeat step 2a through step 4 for 
each facility to be added.

- end -



Facility provisioning   21

AccessNode   Provisioning Quick Reference Guide   P0887750   Issue 1.0

Right oddEnabling or disabling DS1 or STS-1 facility alarms 

Step Action

1 Display the DS1 facility alarm provisioning screen:

fa ds1 <group> <port>; almprov ↵

where
<group> see “Group and slot associations” on page 8
<port> 1 to 14, or all

2 Set the DS1 facility alarm point on or off:

editstat <#> <status>↵
y↵

where
<#> alarm point number
<status> on or off

Repeat this step for each DS1 alarm point to be set.

3 Display the STS-1 facility alarm provisioning screen: 

select sts1 <group> <port>↵

where
<group> STS1 group number
<port> 1 to 14, or all

4 Set the STS-1 facility alarm point on or off:

editstat <alarm point#> <status>↵
y ↵

See step 3 for the parameter values.

5 Repeat from step 3 for each port. 

- end -
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Left even Enabling or disabling DS3, STS-1, OC-3, OC-12, or COMM 
facility alarms 

Step Action

1 Display the alarm provisioning screen for the appropriate facility:
For a DS3 or STS-1 facility, do substep a.
For an OC-3 or OC-12 facility, do substep b.
For a COMM facility, do substep c.

a. Display the DS3 or STS-1 facility screen:

fa <type> <group> <port>; almprov ↵

where
<type> ds3 or sts1
<group> see “Group and slot associations” on page 8
<port> 1 to 3

Go to step 2.

b. Display the OC-3 or OC-12 facility screen:
fa <type> <group>; almprov ↵

where
<type> oc3 or oc12
<group> see “Group and slot associations” on page 8

Go to step 2.

c. Display the COMM screen:

fa comm; ports <type>; dtlport <port>; almprov↵

where
<type> sdcc, eoc, csc, omc, vlcm, cnet, or tmc
<port> port number

2 Set the alarm point on or off:

editstat <#> <status>↵
y ↵

where
<#> alarm point number
<status> on or off

—continued—
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Right oddEnabling or disabling DS3, STS-1, OC-3, OC-12, or COMM facility alarms (continued)

Step Action

Repeat this step for each alarm point to be set.

3 For DS3 or STS-1 alarms, repeat from step 1a for each DS3 or STS-1 
facility. 
For OC-3 or OC-12 alarms, repeat from step 1b for the second group.
For COMM alarms, repeat from step 1c for each channel and port.

- end -

Enabling or disabling TIC/STS-1 and VT1.5 facility alarms

The two tables on page 25 list the default VT1.5 and STS-1 assignments for 
each type of system.

Step Action

1 Display the TIC/STS-1 facility alarm provisioning screen for the 
STS-1 to be provisioned:

fa tic <port #>; almprov↵

where
<port #> number of the STS-1

AccessNode supports STS-1: 1 and 2
AccessNode Express supports STS-1:
1, 2, and 3

If you provisioned default connections, see the 
tables on page 25. If you did not provision 
default connections, refer to the Connection 
Manager tool.

2 Set the STS-1 facility alarm point on or off:

editstat <#> <status>↵
y ↵

—continued—
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Left even
Enabling or disabling TIC/STS-1 and VT1.5 facility alarms (continued)

Step Action

where
<#> alarm point number
<status> on or off

Repeat this step for each alarm to be provisioned. 

3 Return to the TIC/STS-1 facility screen:

quit ↵

4 Display the alarm provisioning screen for the VT1.5 to be provisioned:

subptsel <subport #>; almprov ↵

where
<subport #> 1 to 28

5 Set the VT1.5 facility alarm point on or off:

editstat <#> <status>↵
y↵

See step 2 for the parameter values.

6 Select the next VT1.5 to be provisioned:

select <subport #>↵

See step 4 for the parameter values.

7 Repeat steps 5 and 6 for each VT1.5 to be provisioned.

8 Return to the TIC/STS-1 facility screen:

quit 2 ↵

9 To provision alarms for another STS-1, go to step 10. Otherwise, end 
this procedure here.

10 Display the alarm provisioning screen for the next STS-1 to be 
provisioned:

select <port #>; almprov ↵

See step 1 for the parameter values.

11 Repeat from step 2 for the selected STS-1.

- end -
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Right odd
  

VT1.5 assignments

If you have this 
configuration

Then the VT1.5s assignments are

integrated up to 28 VT1.5s are used on STS-1 #1 (see note)

universal up to 28 VT1.5s are used on STS-1 #2 

integrated, with TR-08 
circuits

VT1.5s 1, 5, 9, 13, 17, 21, and 25 are used for the “A” span on STS-1 
#1, which corresponds to DS1 ports 1, 5, 9, and 13 on DS1 card # 1, 
and DS1 ports 3, 7, and 11 on DS1 card #2 respectively (see note)

Note: For DS1-fed AccessNodes, all GR-303, TR-08, and tandem DS1 traffic must be on DS1/VT 
mappers G1 and G2. DS1/VT mapper G4 can only be used for OMC links.

Default STS-1 assignments 

If you have this type of 
system

Then this STS-1 Carries this type of traffic

Fiber-fed ring no default assignments

Fiber-fed
point-to-point,
integrated (TBM-ABM)

1 GR-303
TR08
DS1 tandem

2 unused

3 transport

4 through 12 (for OC-12 only) transport

Fiber-fed 
point-to-point,
universal (ABM-ABM)

1 GR-303
TR08
DS1 tandem

2 UDLC

3 unused

4 through 12 (for OC-12 only) transport

Single-ended 1 GR-303, TR08, DS1 tandem

2 unused

3 DS1 transport

DS1-fed 1 GR-303, TR08, DS1 tandem,
OMC DS1s

2 OMC DS1s

3 unused
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Left even Provisioning DS1 facility parameters

The table on page 25 lists the DS1 provisioning parameters and their default 
values

Step Action

1 From the NE Status screen, display the facility provisioning screen:

fa ds1 <group> <port>↵

where
<group> see “Group and slot associations” on page 8 
<port> 1 to 14, or all

2 Take the facility out of service:

chgstate oos ↵
y↵

3 Display the edit screen for the facility:

edit↵

4 Set or change any of the parameters listed below.

a. Provision the facility identifier:

facid <identifier>↵

where
<identifier> alphanumeric string to up 38 characters

—continued—

If provisioning Then do 

facility identifier substep a

line coding substep b

line build-out substep c

frame format substep d

alarm encoding substep e

synchronization substep f

performance monitoring substep g
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Right oddProvisioning DS1 facility parameters (continued)

Step Action

b. Provision the type of line coding:

lcoding <type>↵

where
<type> see the table page 28

c. Provision the line build-out range:

lbo <range>↵

where
<range> see the table on page 28

d. Provision the type of framing format:

framefmt <format>↵

where
<format> see the table on page 28

e. Provision the type of alarm coding:

alarmenc <encoding>↵

where
<encoding> see the table on page 28

f. Provision the synchronization mode:

synchr <mode>↵

where
<mode> see the table on page 28

g. Provision performance monitoring:

pmprov <status>↵

where
<status> disable or enable

5 Return the facility to service:

chgstate is ↵

6 Repeat from step 2 for each DS1 facility to be provisioned.

7 Repeat from step 2 for each DS1 group to be provisioned.

- end -
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Left even DS1 provisioning parameters 

Parameter
Setting 

DefaultGR-303 DS1 TR-08 DS1 Tandem 
DS1

Transport 
DS1

facility 
identifier

an alphanumeric string up to 38 characters no entry

line coding b8zs amizcs amizcs, b8zs, or ami ami

line build-out short (0 to 150 ft or 0 to 46 m)

medium (150 to 450 ft or 46 to 137 m)

long (450 to 655 ft or 137 to 200 m)

short

frame format extended 
superframe

with span A: 
dlc

with spans B, 
C and D: 
superframe

superframe 
or extended 
superframe, 
depending 
on the circuit 
order

superframe, 
extended 
superframe, 
dlc for TR-08, 
or null

superframe

alarm 
encoding

ones ones or zeros ones

synchroniza-
tion mode

bytesynchronous asynchronous bytesynchronous

performance 
monitoring

enabled or disabled enabled

DS3 and STS-1 provisioning parameters 

Parameter Setting Default

facility identifier an alphanumeric string up to 38 characters no entry

line build-out cable RG59B/U: short (0 to 164 ft or 0 to 50 m)
long (164 to 250 ft or 50 to 76 m)

cables 734/728A: short (0 to 225 ft or 0 to 68 m)
long (225 to 450 ft or 68 to 137 m)

short

Tx parity correction on or off off

Rx parity correction on or off off

framing for clear-channel DS3s or STS-1s: off
When off is selected, also set Tx and Rx parity to off, and 
ignore DS3 or STS-1 path performance monitoring.

on
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The table on page 28 lists the DS3 and STS-1 provisioning parameters and 
their default values. 

Step Action

1 From the NE Status screen, display the facility provisioning screen:

fa <type> <group> <port>; edit ↵

where
<type> ds3 or sts1 
<group> see “Group and slot associations” on page 8 
<port> for DS3 or STS-1: 1 to 3, or all

2 Take the facility out of service:

chgstate oos ↵
y↵

3 Display the edit screen for the facility:

edit↵

4 Set or change any of the parameters listed below.

a. Provision the facility identifier:

facid <identifier>↵

where
<identifier> alphanumeric string to up 38 characters

—continued—

If provisioning Then do 

facility identifier substep a

line build-out substep b

transmit (Tx) parity correction substep c

receive (Rx) parity correction substep d

framing substep e
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Left even
Provisioning DS3 or STS-1 facility parameters (continued)

Step Action

b. Provision the line build-out range:

lbo <range>↵

where
<range> see the table on page 28

c. Provision the transmit (Tx) parity correction state:

txparity <state>↵

where
<state> see the table on page 28

d. Provision the receive (Rx) parity correction state:

rxparity <state>↵

See substep c for the parameter values.

e. Provision the framing state:

framing <state>↵

See substep c for the parameter values.

5 Return the facility to service:

chgstate is ↵

6 Repeat from step 2 for each DS3 or STS-1 facility to be provisioned.

7 Repeat from step 2 for each DS3 or STS-1 group to be provisioned.

- end -
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Right oddProvisioning OC-3 or OC-12 facility parameters

Step Action

1 Display the OC-3 or OC-12 facility screen:

fa <type> <group>↵

where
<type> oc3 or oc12
<group> see “Group and slot associations” on page 8

2 Select the edit facility screen:

edit ↵

3 Set or change the required facility parameters: For the facility 
identifier, do substep a.

For the signal degrade threshold, do substep b.

For the signal fail threshold, do substep c.

a. Provision the facility identifier:

facid <identifier>↵

where
<identifier> to 38 alphanumeric characters

b. Provision the exponent for the signal degrade threshold:

linesdth <exponent>↵

where
<exponent> 4, 5, 6, 7, 8, 9, or 10

for example, 4 represents 1.0E-4 (1x10-4)

c. Change the OC-3 or OC-12 signal fail threshold:

linesfth <exponent>↵

where
<exponent> 3, 4, or 5

4 Repeat from step 1 for each optical facility.

- end -
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Left even Provisioning DS1, DS3, STS-1, OC-3, OC-12, VT path, or STS 
path facility performance monitoring thresholds 

Step Action

1 From the NE Status screen, display the performance monitoring 
screen:

pm↵

2 Select a facility:
For DS1, DS3, or STS-1, do substep a.
For OC-3 or OC-12, do substep b.
For STS path, do substep c.
For VT path, do substep d.

a. Select a DS1, DS3, or STS-1 facility:

facperf <type> <group> <port> <direction>↵

where
<type> ds1, ds3, or sts1
<group> see “Group and slot associations” on page 8
<port > for DS1: 1 to 14; for DS3 or STS-1: 1 to 3
<direction> for DS3 only: tx or rx

Go to step 3.

b. Select an OC-3 or OC-12 facility:

facperf <type> <group> <origin> ↵

where
<type> oc3 or oc12
<group> see “Group and slot associations” on page 8
<origin> for OC12 only: near or far (default is near)

Go to step 3.

—continued—
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Right oddProvisioning DS1, DS3, STS-1, OC-3, OC-12, VT path, or STS path facility 
performance monitoring thresholds (continued)

Step Action

c. Select an STS path:

facperf path sts oc12 <group> <sts #> <origin> ↵

where
<group> see “Group and slot associations” on page 8
<sts #> 1 to 12
<origin> near or far (default is near)

Go to step 3.

d. Select a VT path:

facperf path vt ds1 <group> <port #> ↵

where
<group> see “Group and slot associations” on page 8
<port> 1 to 14

3 Display the thresholds edit screen:

threshld; edit ↵

4 Set or change any of the parameters listed below:

—continued—

If you want to generate Then do

section report for OC-3 or OC-12 substep a

line or path report for DS1 or
path report for VT or STS path

substep b

line report for DS3, STS-1, OC-3, or OC-12 substep c

path report for DS3 substep d

status of threshold one for DS1, DS3, STS-1, OC-3, or 
OC-12

substep e

value of threshold one for DS1, DS3, STS-1, OC-3, or 
OC-12

substep f

status of threshold two for DS1, DS3, STS-1, OC-3, or 
OC-12

substep g

value of threshold two for DS1, DS3, STS-1, OC-3, or 
OC-12

substep h
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Provisioning DS1, DS3, STS-1, OC-3, OC-12, VT path, or STS path facility 
performance monitoring thresholds (continued)

Step Action

a. Provision the report type to be generated for OC-3 or OC-12 
when a section threshold is crossed:

srpttype <type>↵

where
<type> alm or palrt

b. Provision the line or path report type as alm or palrt for DS1, STS 
path, or VT path:

rpttype <type>↵

See substep a for the parameter values.

c. Provision the line report type as alm or palrt for DS3, STS-1, 
OC-3, or OC-12:

Irpttype <type>↵

See substep a for the parameter values.

d. Provision the path report type as alm or palrt for DS3:

prpttype <type>↵

See substep a for the parameter values.

e. Provision the first threshold status:

statust1 <parameter> <status>↵
y ↵

where
<parameter> for DS1 Rx, OC-3, or OC-12 Rx: 1 to 8

for DS3 Rx: 1 to 9
for DS3 Tx: 1 to 6
for STS path: 1 to 4
for VT path: 1 to 2

<status> on or off (if you do not enter the status, the value 
toggles)

—continued—
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Right oddProvisioning DS1, DS3, STS-1, OC-3, OC-12, VT path, or STS path facility 
performance monitoring thresholds (continued)

Step Action

f. Provision the first threshold value and interval:

valuet1 <parameter #> <threshold> <interval>↵
y↵

where
<parameter> see substep e
<threshold> for untimed: 1 to 4294967295

for day: 1 to 33152
for 15min: 1 to 1388700

<interval> 15min, day, or unt

g. Provision the second threshold status:

statust2 <parameter #> <status>↵
y ↵

See substep e for the parameter values.

h. Provision the second threshold value and interval:

valuet2 <parameter #> <threshold> <interval>↵
y ↵

See substep f for the parameter values.

5 Repeat from step 2 for each facility, path, or optical group.

- end -
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Left even  Provisioning SDCC connections

Step Action

1 Display the COMM facility screen:

fa comm; ports sdcc;dtlport <port>↵

where
<port>is one of the following:

2 Select add.

3 If you are installing a single-ended AccessNode, repeat this 
procedure for the other NE.

If you are connecting to other equipment that requires SDCC, enable 
the SDCC on that equipment.

- end -

If you are provisioning this group Then select this 
SDCC port number

g3 1

g4 2

g1s/g2s 3

g2s 4

g1 5

g2 6

g5 7

g6 8

g7 9

g8 10



Synchronization   37

AccessNode   Provisioning Quick Reference Guide   P0887750   Issue 1.0

Right oddSynchronization
For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Enabling or disabling timing reference alarms

Step Action

1 From the NE Login Manager screen, log in to the NE you want to 
provision.

2 Display the timing reference protection screen:

protectn; trefprot ↵

3 Display the timing reference provisioning screen:

almprov ↵

4 Enable or disable a specific alarm:

editstat <alarm point#> [<state>] ↵
y ↵

where
<alarm point#> number of the alarm
<state> on or off, or blank to toggle

- end -
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Left even Provisioning ESI or TXC equipment alarm points

Step Action

1 From the NE Login Manager screen, log in to the NE you want to 
provision.

2 Complete the instructions in the following table.

3 Display the Equipment Alarm Provisioning screen by entering:

almprov↵

4 Set the alarm points to either On or Off by entering:

editstat <#> <status>↵

y↵

5 Repeat step 4 for each alarm point to be provisioned.

6 Repeat steps 1 through 4 for each ESI or TXC to be provisioned.

- end -

If you want to 
provision

Then enter

ESI alarm points eq esi <group>↵
where

<group>  g1  or g2 
TXC alarm points eq txc <group>↵

where

<group>  g1 or g2

where

<#> the number of the alarm point

<status> on or off
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Right oddEnabling or disabling ESI facility alarms

Step Action

1 From the NE Login Manager screen, log in to the NE you want to 
provision.

2 Display the ESI alarm provisioning screen:

fa esi <type>; almprov ↵

where
<type> bitsa, bitsb, g1out, or g2out

3 Set the alarm points on or off:

editstat <#> <status>↵
y↵

where
<#> number of the alarm point
<status> on or off

4 Repeat step 3 for each alarm point to be set.

5 Repeat from step 2 for each ESI facility.

- end -
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Left even Provisioning synchronization-status messaging

To provision synchronization-status messaging for an OC-12 VTBM system, 
you must log in to one network element at a time and repeat the steps in this 
procedure for each network element in the system.

Step Action

1 Set the network element clock source by entering:

eq sh; edit↵
clocksrc <clock source type>↵
yes↵

2 Access the Timing Reference Source screen by entering:

pr tp;trefsrc↵

3 Change the OCA and OCB source by entering either:

ocasrc <unit>↵ or ocbsrc <unit>↵

Note: The ocasrc and ocbsrc command works only if the Source 
Tracking field on the G1OUT and G2OUT facility screens displays Off.

—continued—

where

<clock source type> ESI or linetimed 

where

<unit> g1 for ocasrc and g2 for ocbsrc



Synchronization   41

AccessNode   Provisioning Quick Reference Guide   P0887750   Issue 1.0

Right oddProvisioning synchronization-status messaging (continued)

Step Action

Provisioning the ESI inputs (BITSA and BITSB)
4 Access the ESI Facility BITSA/BITSB Edit screen by entering:

fa esi <unit>↵

5 If the network element is not externally timed, put BITSA and BITSB 
out of service (OOS) by entering:

chgstate oos↵
yes↵

6 You must change the framing format parameter of BITSA and BITSB 
if the network element meets the following conditions:

• The network element is externally timed.

• The network element is connected to a BITS that supplies DS1s 
with the extended superframe framing format.

To change the framing format, enter:

sigfmt cc↵

Note: The ESI BITSA/BITSB facility must be out of service before you 
change the frame format.

Provisioning the timing sources for the network element
7 Determine if the shelf has an ESI.

—continued—

where

<unit> bitsa or bitsb

If the shelf Complete the following
has an ESI a. eq esi <circuit pack group>↵

where
<circuit pack group> g1 or g2
b. Change the target clock mode by 
entering:
edittarg holdover↵

does not have an 
ESI

protectn↵
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Left even
Provisioning synchronization-status messaging (continued)

Step Action

8 Determine if the shelf is DS1-fed.

9 Change the timing reference source: 

source <reference #> <unit> ↵  
yes ↵   

Repeat this step for each timing source as required.

10 If necessary, specify the quality level of a timing source by entering:

qlevel <reference #> <quality level> ↵
yes ↵

—continued—

If the shelf Complete the following
is DS1-fed trefsrc <source>↵

where
<source> REFASrc

REFBSrc
is not DS1-fed trefprot↵

edit↵

where

<reference #> 1, 2, 3, or 4

<unit> bitsa, bitsb, g1, g2, or null
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Right oddProvisioning synchronization-status messaging (continued)

Step Action

11 Complete the instructions in the following table.

Provisioning timing distribution
Note: Unless the network element will provide timing distribution to a 
TransportNode system, put the ESI DS1 outputs (G1OUT and 
G2OUT) out of service.

—continued—

where

<reference #> 1, 2, 3, or 4

<quality level> ST1       Stratum 1
STU      stratum traceability unknown
ST2       Stratum 2
ST3       Stratum 3
SMC      +/− 20 ppm clock
DUS      do not use for synchronization
AUTO    reset the quality level to the level received
               in the synchronization status message

If the shelf Complete the following
has an ESI a. eq <circuit pack group>↵

where

<circuit pack 
group>

g1or g2

b. Change the target filter mode by 
entering:
edittarg normal↵

does not have an 
ESI

The procedure is complete.
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Left even
Provisioning synchronization-status messaging (continued)

Step Action

12 Access the ESI Facility G1OUT and G2OUT screens by entering:

fa esi <unit>↵

13 Complete the instructions in the following table:

14 Determine the source for timing distribution.

—continued—

where

<unit> g1out or g2out

If the network element will Do the following
use DS1s with the extended 
superframe format to provide 
timing distribution

Change the framing format 
by entering:

edit↵
framefmt extended↵

not provide timing distribution to 
a BITS

chgstate oos↵
yes↵
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Step Action

15 Complete the instructions in the following table:

Provisioning the threshold AIS generation mode at network 
elements that will provide timing distribution
16 At the ESI Facility G1OUT screen and at the ESI Facility G2OUT 

screen, change the threshold AIS parameter by entering:

thresais <quality level>↵

- end -

To provision the timing 
distribution to follow

Do the following

the best quality-timed 
OC-12 line

Enter:

srctrack best↵
yes↵

Note: The Source Tracking field 
must display Off for this command 
to work. If the field displays Act, 
enter srctrack off, then enter 
srctrack best.

a fixed OC-12 line Enter:
source <source>↵
where
<source> oca or ocb
Note: The Source Tracking field 
must display Off for this command 
to work.

where

<quality level> st2, st3, or smc to set the threshold AIS

null to disable the threshold AIS
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For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Selecting the Hong Kong PSTN load

Use this procedure only when installing a network element in Hong Kong. 
When you change the PSTN load, all active calls are dropped and all active 
line testing is canceled.

Step Action

1 From the NE Login Manager screen, log in to the NE you want to 
provision.

2 Exit to the CI prompt:

quit all ↵

3 Open the PSTN CI tool:

pstnci ↵

4 Determine the status of the PSTN load:

qpstn ↵

5 If the load is North American and you are in Hong Kong, change the 
PSTN load:

selhk ↵
y ↵

6 Close the PSTN CI

tool:

quit ↵
- end -
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For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Setting the Hong Kong adjustable gain

Use this procedure only when installing a network element in Hong Kong. 
When you change the PSTN load, all active calls are dropped and all active 
line testing is canceled.

Step Action

1 From the NE Login Manager screen, log in to the NE you want to 
provision.

2 Exit to the CI prompt:

quit all ↵

3 Open the LNADJ CI tool:

lnadjci ↵

4 Determine the status of the LNADJ by entering:

queryattrib <start shelf type> <shelf number> <slot number> 
>end shelf type> <shelf number> <slot number>

queryattrib cds 1 1 cds 1 5

5 Change the adjustable gain by entering:

setpots <shelf type> <service type> <attributes>↵

setpots cds 1 1 lpstres txgain ‘-0.0’
setpots cds 1 1 lpstres rxgain ‘-10.0’

6 Reset the adjustable gain to the default values by entering:

defaultpots <shelf type>

7 Close the LNADJ CI tool:

quit ↵
- end -
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Left even Host provisioning
This task is performed at the OPC. For a summary of the keystrokes required 
to navigate in an OPC screen, see “Using the OPC UI” on page 2.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Adding a new host to an RFT

Step Action

1 Select the Host Provisioning Manager tool from the Prov Admin 
toolset.

2 From the Host Provisioning Manager main window, display the RFT 
chooser menu and select the RFT.

3 In the Add Host field, type the Host CLLI (up to 16 characters) of the 
host you want to add, then press Return.

- end -

Making a host the primary alarm host

Step Action

1 Select the Host Provisioning Manager tool from the Prov Admin 
toolset.

2 From the main window of the Host Provisioning Manager, display the 
RFT chooser menu and select the RFT.

3 Select the host you want to be the primary alarm host.

4 Select Make Primary from the list item menu.

5 Select OK to complete the process. 

- end -
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This task is performed at the OPC. For a summary of the keystrokes required 
to navigate in an OPC screen, see “Using the OPC UI” on page 2.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Scheduling an audit of configuration data

Step Action

1 Select the Configuration Manager tool from the Network Admin 
toolset. 

2 In the Configuration Manager main window, select the ring for which 
you want to schedule an audit.

3 Select Edit/Delete configuration from the list item menu.

4 In the Configuration Manager: Ring window, select Schedule 
configuration audits from the Options menu.

To enter the default settings (daily, starting at 6:30 a.m. today), do 
step 5. To enter any other setting, go to step 6.

5 In the Schedule Configuration Data Audit dialog, select Default. Go 
to step 7.

6 To enter non-default settings:

a. In the Run every field, specify how often the audit is to run. The 
value you type here depends on the unit of time you select.

For minute(s) the valid values are: 15 to 59
For hour(s) the valid values are: 1 to 23
For day(s) the valid values are: 1 to 7

b. Select the time button that corresponds to the desired unit of 
time: minute(s), hour(s), or day(s).

—continued—
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Left even
Scheduling an audit of configuration data (continued)

Step Action

c. In the Next run field, type the hours and minutes, separated by a 
colon (hh:mm).

d. In the date field, select today or tomorrow from the chooser 
menu.

7 Select OK to update the audit schedule.

8 Return to the Configuration Manager main window.

- end -
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Each ring ADM must have a unique APS ID.

Step Action

1 From the Configuration Manager main window, select the ring you 
want to edit.

2 Select Edit configuration from the ring list item menu.

3 In the Configured Ring ADM list in the Configuration Manager: Ring 
window, select the ring ADM to be edited.

4 Select Edit from the list item menu for the ring ADM.

5 From the cascade menu that appears, select APS ID.

6 In the Ring ADM APS ID field of the Edit Ring ADM APS Id dialog, 
select the new ID from the chooser menu.

7 Select OK to update the APS ID and close the dialog.

8 Repeat steps 3 to 7 for each APS ID to be edited.

9 Select Save and send configuration, then select Yes to continue 
the operation.

10 Select Done to return to the Configuration Manager: Ring window.

11 To save the revised configuration data, select Transfer data to 
backup OPC from the Options menu. 

12 Select Yes to confirm the save operation.

13 Select Done to return to the Configuration Manager: Ring window.

- end -

CAUTION
Risk of traffic loss
This procedure might affect traffic if it is performed while a protection 
switch is active.
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Step Action

1 In the Configuration Manager main window, select the ring that 
contains the ring ADM.

2 Select Edit configuration from the ring list item menu.

3 From the Configured Ring ADM list in the Configuration Manager: 
Ring window, select the ring ADM that requires new configuration 
data.

4 Select Send node map to NE from the list item menu for the ADM, 
then select Yes.

5 Select Done to close the confirmation dialog.

- end -

Editing the ring name

Step Action

1 In the Configuration Manager main window, select the ring you want 
to edit.

2 Select Edit configuration from the ring list item menu.

3 In the Configuration Manager: Ring window, select Edit 
Configuration Name from the Options menu.

4 In the Name field of the Edit Configuration dialog, backspace over the 
existing name and type a new name (up to 20 characters).

5 Select OK, then select Yes to complete the operation. 

- end -
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This task is performed at the OPC. For a summary of the keystrokes required 
to navigate in an OPC screen, see “Using the OPC UI” on page 2.

If you are logged in to the primary OPC, your connection changes are 
transferred to the backup OPC when you save them. If you are logged in to 
the backup OPC, you must repeat the connection changes on the primary OPC 
when it becomes active.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Provisioning and Operations 
Procedures, 323-3001-310, in Operations, Administration, and Provisioning, 
Volume 4B. 

Modifying the list of connections

Step Action

1 From the Connection Manager main window, display the View menu.
To sort the connections in the list, go to step 2.
To filter connections from the list, go to step 3.

2 To sort the connections:

a. Select Sort from the View menu. 

b. From the cascade menu that appears, select the sorting option. 

Go to step 1. 

3 From the View menu, select Filter.

The Filter dialog displays all NEs in the OPC span of control

—continued—
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Left even
Modifying the list of connections (continued)

Step Action

4 Determine what you want to do:

5 To exclude all STS connections:

a. Display the list item menu for an end NE on the connection you 
want to exclude and select Remove.

b. From the cascade menu that appears, select:
This NE to exclude the selected NE, or 
This Configuration to exclude all NEs in the ring.

c. Move to the other end NE for the connection and repeat 
substeps a and b.

d. Select Apply to revise the list as specified. Go to step 4.

6 To display new or modified connections only, select New or modified 
connections only in the Filter dialog. Go to step 4.

7 To display STS-managed and VT-managed connections, select All in 
the Filter dialog. Go to step 4.

8 To display only STS-managed connections, select STS-managed 
only in the Filter dialog. Go to step 4.

9 To display only VT-managed connections, select VT-managed only 
in the Filter dialog. 
Go to step 4.

—continued—

If you want to display Then do

no STS connections step 5

only new or modified connections step 6

STS- and VT-managed connections step 7

only STS-managed connections step 8

only VT-managed connections step 9

the revised connection list to confirm the revisions step 10
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Step Action

10 To confirm that the revisions have been applied, display the revised 
Connection list in the main window (Ctrl_W +). 

If you want to return to the Filter dialog and select another option, 
press +. Otherwise, select OK to close the Filter dialog and return to 
the Connection Manager main window.

- end -

Finding available tributaries

Step Action

1 From the Connection Manager main window, display the Options 
menu (Ctrl_L T, then Shift +).

2 Display the Options menu (Ctrl_L T, then Shift +), and select Show 
tributary usage.

3 In the Configuration field of the Tributary Usage dialog, select the 
required configuration from the chooser menu.

4 In the NE field, select, from the chooser menu, one of the end NEs in 
the connection.

The NE ID appears in the field, and associated tributary facilities 
appear in the Tributary list.

5 Do one of the following:

6 For an STS-1 or STS-3c connection, locate an available tributary 
facility (not “VT-managed” or “unavailable”) in the Tributary list and 
note the card type, circuit pack group number, and port number. 

—continued—

If you are provisioning Then go to

an STS-1 or STS-3c connection step 6

a VT1.5 connection step 8
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Finding available tributaries (continued)

Step Action

7 Repeat steps 4 and 6 for the other end NE in the connection. Go to 
step 16. 

8 For a VT1.5 connection, locate (in the Tributary list) a DS-1 tributary 
that is available or VT-managed and note the card type and circuit 
pack group number.

9 Select a VT-managed tributary in the Tributary Usage list.

10 Select View Subrate Usage from the tributary list item menu.

11 Locate an available port in the Subrate Usage dialog and note the 
port number.

12 Select Done to close the Subrate Usage dialog and return to the 
Tributary Usage dialog.

13 In the NE field, select the other end NE from the chooser menu.

14 Repeat steps 9 to 12 for the other end NE in the connection. Go to 
step 16. 

15 In the NE field, select, from the chooser menu, the other end NE and 
note the card type and circuit pack group number. 

16 Select Done to close the Tributary Usage dialog.

- end -

If the tributary is Then

available You can use any port for the VT1.5 
connection. Go to step 15. 

VT-managed You must view the tributary subrate 
usage to find an available port on the 
tributary. Go to step 9.
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Step Action

1 From the Connection Manager main window, display the Options 
menu (Ctrl_L T, then Shift +).

2 Select Show STS-1 channel usage in the Options menu.

3 In the Configuration field of the resulting dialog, select the required 
configuration from the chooser menu.

4 In the End NE A field, select, from the chooser menu, one of the end 
NEs that terminate the connection.

5 In the End NE Z field, select the other end NE from the chooser menu.

6 Do one of the following:

7 For an STS-1 connection, locate an available STS-1 channel in the 
STS-1 Usage list, and note the channel number. 

For an STS-3c connection, locate three available STS-1 channels 
that are consecutive and adjacent, and note the first channel number 
(1, 4, 7, or 10). 

8 Select Done to return to the Connection Manager main window.
Go to step 12. 

9 For a VT1.5 connection:
If the Usage column shows Not available and the Complete 
VT-Managed STS-1 Channel column shows Available, the channel 
provides contiguous VT-managed STS-1 bandwidth. 

To find out if there is available VT channel bandwidth, select an STS-1 
channel that shows Not Available in the Usage column and Available 
in the Complete VT-Managed STS-1 Channel column.

10 Select Show VT Channel Usage from the list item menu for the 
highlighted channel. 

11 In the VT Channel Usage dialog, locate an available VT group and 
number and note this information.

12 Select Done twice to return to the Connection Manager main window.

- end -

If you are provisioning Then go to

an STS-1 or STS-3c connection step 7

a VT1.5 connection step 9
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Step Action

1 In the Connection Manager main window, select Add.

2 In the Connection ID field in the Add connection dialog, type a unique 
name for the connection (up to 40 alphanumeric characters). This is 
an optional field.

3 In the Configuration field, select the required configuration from the 
chooser menu.

4 Specify the connection details:

a. In the STS-1 Channel field, select the STS-1 channel from the 
chooser menu.

Note: To set up a single connection for an STS-3c signal, manually 
connect three consecutive STS-1 channels. STS-3c connections are 
only supported on channels 1 to 3, 4 to 6, 7 to 9, or 10 to 12. 

b. In the Level field, select VT-managed or STS-managed. 

c. In the End NE A field, select from the chooser menu one of the 
end NEs that terminate the connection.

d. In the Tributary field, type the tributary facility information you 
noted in the list of STS-1 connections.

The Group and Slot fields are automatically filled in.

Note: When adding an STS-1 connection between DS1s to obtain 
end-to-end continuity, ensure that an odd circuit pack group at one 
end is connected to an odd circuit pack group at the other end (for 
example, G5 to G1, or G3 to G7).

e. In the STS-1 Channel field, type the channel information you 
noted in the list of STS connections.

f. Move to the End NE Z field and repeat substeps c to e for the 
other end NE in the connection.

5 Select OK, then select Yes to confirm the data.

6 Select OK to return to the Connection Manager main window.

- end -
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To provision VT1.5 connections, you must first add VT-managed STS-1 
connections to the connection data.

Step Action

1 In the Connection Manager main window, select Add. 

2 In the Connection ID field, type a unique name for the new 
connection.

3 In the Configuration field, select the required configuration from the 
chooser menu.

4 Specify the connection details:

a. In the STS-1 Channel field, type the STS-1 channel number from 
your list.

b. In the Level field, select VT-Managed from the chooser menu.

c. In the End NE A field, select, from the chooser menu, the NE at 
one end of the connection.

d. In the End NE Z field, select, from the chooser menu, the other 
end NE in the connection.

e. Select the Route button corresponding to the correct route. 

5 Select Apply.

6 Check that the connection data is correct, then select Yes and OK.

7 Select OK to return to the Connection Manager main window.

—continued—

If the VT-managed STS-1 connection Then

spans two or more rings in the same 
OPC span of control

Repeat steps 1 to 6 for 
each additional ring. 
Then go to step 8.

is in a single ring in the same span of 
control

Go to step 8. 
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Left even
Adding a VT connection (continued)

Step Action

8 Provision the VT1.5 connections for the VT-managed STS-1 
connection:

a. Select Manage VT connections from the list item menu for the 
VT-managed STS-1 connection. 

b. Select Add.

9 In the Connection ID field, type a unique name for the new connection 
(up to 40 alphanumeric characters). 

10 In the Tributary field for Connection Termination A, type the VT group 
and VT number from your list.

11 In the Tributary field for Connection Termination Z, type the VT group 
and VT number from your list.

12 Continue to enter information from your list: 

13 To select fields to remain on screen:

a. Select the Preference button in the Add VT Connection dialog.

b. In the Set Preferences Apply dialog, select the fields you want to 
preserve and deselect the fields you want to clear.

An asterisk appears beside each field you select.

c. Select OK to close the Set Preferences for Apply dialog.

14 To add the connection and keep the dialog open:

a. In the Add VT Connection dialog, select Apply.

b. Check the data then select Yes to add the connection.

—continued—

If you want to Then do

select fields to remain on screen when you add a 
VT1.5 connection using Apply in the VT Connection 
dialog

step 13

add the connection to the connection list and keep the 
Add VT Connection dialog open

step 14

add the connection to the connection list and close 
the Add VT Connection dialog

step 16
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Step Action

15 Repeat steps 9 to 12 to add other connections.

16 Select OK. If the data is correct, select Yes.

17 Select OK to confirm the data and add the connection.

- end -

Editing an STS connection

Step Action

1 In the Connection Manager main window, move to the Connection ID 
field, and select the connection to be edited.

2 Select Edit from the list item menu for the connection. 

3 In the Connection ID field, type a unique name for the connection, 
then select OK.

4 Select Yes to confirm the data, then select OK to update the 
connection data and return to the Connection Manager main window. 

- end -
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To edit any connection information other than the connection ID for a 
VT-managed STS-1 connection, first delete the VT1.5 connections that the 
VT-managed STS-1 connection carries.

The connection ID can be edited in service. However, the facilities must be 
out of service before you can edit any other connection information.

Step Action

1 In the Connection Manager main window, display the Options menu 
(Ctrl_L T, then Shift +), and select Manage VT connections. 

2 In the Configuration field of the Manage VT Connections dialog, 
select the required configuration from the chooser menu.

3 Specify the connection details:

a. In the End NE A field, select from the chooser menu one of the 
end NEs that terminate the connection.

b. In the End NE Z field, select from the chooser menu the other 
end NE that terminates the connection.

c. In the STS-1 Channel field, type the STS-1 channel for the 
connection.

d. Select the Route button corresponding to the correct route. 

4 In the connection list, move to the VT1.5 connection to be edited.

—continued—

CAUTION
Risk of traffic loss
If the facility assignment of a DS1-TIC VT connection is edited 
with the facilities in service, traffic will be lost. Ensure that the 
facilities are out of service before editing connection information.

If you want to edit Then go to

a VT-managed STS connection step 16

a VT1.5 connection step 1
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Step Action

5 Select Edit from the list item menu for the connection.

6 Do one of the following:

7 In the Connection ID field, type a unique name for the connection. Go 
to step 6.

8 In the Facility Assignment field, select Tandem from the chooser 
menu. Go to step 6.

9 For GR-303 service:

Note: Before assigning a facility, unassign the facility and deprovision 
the line terminations. 

a. In the Facility Assignment field, select Assign as GR-303 from 
the chooser menu.

b. In the IG Number field of Assign DS1 as GR-303 DMS dialog, 
select the required IG number from the chooser menu.

The host name appears in the Host Name field and a link number 
in the RDT Link Number field. 

The RDTLink Number assigned to the DS1 port must match the 
RDTLink number assigned to the port (SMA port for a DMS) to 
which it is physically connected. 

Table RDTINV on the Host contains the RDTLink Number to the 
port pairings. This number is the next available logical number for 
the Host.

—continued—

If you want to change the Then do

connection ID step 7

DS1 assignment to tandem service step 8

DS1 assignment to GR-303 DMS service step 9

DS1 assignment to TR-08 service step 10

DS1 assignment to VLCM step 11

DS1 assignment to Data Direct step 12

DS1 assignment to unassigned step 13

To save your changes step 14
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Editing a VT connection (continued)

Step Action

c. In the RDTLink Number field, type a different number if desired.

d. Select OK. Go to step 6. 

10 For TR-08 service:

a. In the Facility Assignment field, select Assign as TR-08 from the 
chooser menu.

b. In the System Number field of the Assign DS1 as TR-08 dialog, 
select the required system number from the chooser menu.

c. If you want to change the ID, move to the Link ID field, and select 
a new link ID from the chooser menu.

d. Select OK. Go to step 6.

11 To change the DS1 assignment to VLCM service:

a. Use the arrow keys to move to the Assign as VLCM command.

b. In the System Number field, press Ctrl_L (or Keypad 3) to 
display the chooser menu.

c. Select the required system number, then select Space. Go to 
step 6.

12 To change the DS1 assignment to Data Direct, move to the Assign 
as Data Direct command, then press Space. Go to step 6.

13 To remove the DS1 assignment, select Unassigned from the 
chooser menu in the Facility Assignment field. Go to step 6.

14 To save the changes, select OK; then select Yes to confirm your 
request.

15 Select OK to update the VT1.5 connection list; then select Done to 
return to the Connection Manager main window.

—continued—
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Step Action

16 If you want to edit a VT-managed STS connection:

a. From the Connection Manager main window, select the 
VT-managed STS-1 connection to be edited.

b. Select Edit from the connection list item menu.

c. In the Connection ID field, type a unique name for the 
connection, then select OK.

d. Select Yes to confirm the data, then select OK to update the 
connection data. 

17 Select OK to return to the Connection Manager main window.

- end -
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Use this procedure to delete an STS connection between two network 
elements in the operations controller (OPC) span of control. 

When deleting an STS-1 connection that terminates on TIC port 1, if the 
association to the RFT containing the TIC is up, facility assignments are 
checked. If there are any facilities assigned for GR-303, TR-08, or Tandem 
services on that connection, you must unassign the facilities before you delete 
them.

Step Action

1 In the Connection Manager main window, select the connection you 
want to delete. 

2 Select Delete from the list item menu. 

3 Select Yes to confirm the change. 

- end - 

CAUTION
Risk of traffic loss
This procedure affects any traffic being carried by the connection. Ensure 
that the equipment is out of service before you delete a connection. 

CAUTION
Risk of traffic loss
The Connection Manager allows connections to be deleted when the 
association to the RFT containing the TIC is down. When the association to 
the RFT containing the TIC is down, facility assignments cannot be 
checked. To avoid deleting a connection that might still have DS1 facility 
assignments, do not delete a connection when the association to the RFT 
containing the TIC is down.
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Use this procedure to delete a VT-managed STS-1 connection between two 
network elements in the OPC span of control. Delete all VT1.5 add-drop and 
pass-through connections before you perform this procedure.

When deleting an STS-1 or VT connection that terminates on TIC port 1, if 
the association to the RFT containing the TIC is up, facility assignments are 
checked. If there are any facilities assigned for GR-303, TR-08, or Tandem 
services on that connection, you must unassign the facilities before you delete 
them. 

Step Action

Step Action

1 In the Connection Manager main window, select the connection you 
want to delete. 

2 Select Show Contained VTs from the list item menu. 

3 Select Delete from the list item menu. 

—continued—

CAUTION
Risk of traffic loss
This procedure affects any traffic being carried by the connection. Ensure 
that the equipment is out of service before you delete a connection. 

CAUTION
Risk of traffic loss
The Connection Manager allows connections to be deleted when the 
association to the RFT containing the TIC is down. When the association 
to the RFT containing the TIC is down, facility assignments cannot be 
checked. To avoid deleting a connection that might still have DS1 facility 
assignments, do not delete a connection when the association to the RFT 
containing the TIC is down.
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Deleting a VT-managed STS-1 connection (continued)

Step Action

4 Select Yes then select the Done.

5 Select Delete from the list item menu. 

6 Select Yes to confirm the change. 

- end -



Setting up connections at the OPC   69

AccessNode   Provisioning Quick Reference Guide   P0887750   Issue 1.0

Right oddDeleting a VT connection

Use this procedure to delete a VT connection between two network elements 
in the OPC span of control. The connection is removed permanently from the 
OPC and network element connection data. 

When deleting a VT connection that terminates on TIC port 1, if the 
association to the RFT containing the TIC is up, facility assignments are 
checked. If there are any facilities assigned for GR-303, TR-08, or Tandem 
services on that connection, you must unassign the facilities before you delete 
them. 

Step Action

1 From the Connection Manager main window, display the Options 
menu and select Manage VT connections.

2 In the Configuration field, select the configuration you want from the 
chooser menu.

3 In the STS-1 Channel field, enter the STS-1 channel for the 
connection you want to delete.

4 In the End NE A field, select from the chooser menu one of the end 
NEs that terminate the connection.

5 In the End NE Z field, select from the chooser menu the other end NE 
that terminates the connection.

—continued—

CAUTION
Risk of traffic loss
This procedure affects any traffic being carried by the connection. Ensure 
that the equipment is out of service before you delete a connection. 

The Connection Manager allows connections to be deleted when the 
association to the RFT containing the TIC is down. When the association to 
the RFT containing the TIC is down, facility assignments cannot be 
checked. To avoid deleting a connection that might still have DS1 facility 
assignments, do not delete a connection when the association to the RFT 
containing the TIC is down.
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Left even
Deleting a VT connection (continued)

Step Action

6 Select the Route button corresponding to the correct route. 

7 Select Delete from the list item menu. 

8 Select Yes and Done to confirm the change. 

- end -
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OPC data is compared with data from all NEs in the OPC span of control. For 
results of the audit, see the Event Browser.

Step Action

1 In the Connection Manager main window, display the Options menu 
(Ctrl_L T, then Shift +) and select Schedule connection audits.

To enter the default settings (7 a.m. daily, starting tomorrow, if it is 
now later than 7 a.m.), do step 2. 
To change the frequency of the audit, go to step 3.

2 Select Default in the Schedule Connection Data Audit dialog. Go to 
step 4.

3 To change the frequency of the audit:

a. In the Run every field, type how often the audit is to run. The 
value you type here depends on the unit of time:

For minute(s), the valid values are: 15 to 59
For hour(s), the valid values are: 1 to 23
For day(s), the valid values are: 1 to 7

b. Select the Time button that corresponds to the desired unit of 
time (minutes, hours, or days).

c. In the Next run field, type the hours and minutes, separated by a 
colon (hh:mm).

d. In the date field, select today or tomorrow from the chooser 
menu.

4 Select OK to update the audit schedule.

- end - 
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This task is performed at the OPC. For a summary of the keystrokes required 
to navigate in an OPC screen, see “Using the OPC UI” on page 2.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Line Card Provisioning Procedures, 
323-3001-315, in Operations, Administration, and Provisioning, Volume 4B. 

Bulk-provisioning POTS service on a universal system

When typing a range of shelves or slots, separate the start and end of the range 
by a dash.

Step Action

1 In the Default Provisioning tool main window, move to the first NE 
field.

2 Display the chooser menu and select the NE for which you want to 
provision circuits.

To provision a range of circuits in one or more shelves, go to step 3.

To provision all circuits between the NE pair, go to step 6.

3 In the CD shelf field for the NE, type the shelf number or range of 
shelves to be provisioned. 

4 If provisioning a single slot or range of slots in a single shelf, type the 
slot number or range of slots in the Slot field.

5 Repeat steps 3 and 4 for the other NE.

Note: The number of shelves or slots in the range must be the same 
for both the NE pair. 

6 To provision the circuits, select Provision.

7 Check the information displayed then select Yes.

8 Select Done to return to the main window.

- end -
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Before performing this procedure, assign DS1s for TR-08 service using the 
Connection Manager tool.

Step Action

1 From the TR-08 Default Provisioning tool main window, move to the 
first NE field. 

2 Display the chooser menu for the first NE field and select the NE ID 
of the NE with the links. 

3 In the TR-08 System field, select the TR-08 system number from the 
chooser menu.

4 If the second NE field is not already filled in, select the NE ID from the 
chooser menu.

5 In the CD Shelf field, type the shelf number.

6 In the Service field for link A, select, from the chooser menu, the type 
of service to be assigned to the link: POTSRT, UVGRT, COINRT, or 
DPT.

Repeat this step for links B, C, and D. 

7 To provision the circuits, select Provision.

8 Check the information displayed then select Yes. 

9 Select Done to return to the main window.

- end -
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Step Action

1 From the Provisioning Manager main window, display the Operations 
menu and select Add Circuit.

2 Tab from field to field while filling in the NE, CDS, and slot information 
you have readily available. 

3 Continue entering data and selecting choices until all fields are filled 
in then select OK. 

4 Specify the circuit details:

a. In the Circuit ID field, type a CLLI for the circuit (up to 40 
characters).

b. In the Loop type field for the first NE, type the loop type or select 
it from the chooser menu.

c. In the Service Code field, type the service code, or select it from 
the chooser menu.

(If only one service code is valid for the other NE, the loop type 
and service code are automatically filled in. Go to substep e.) 

d. If the loop type and service code are not automatically filled in, 
enter values in these fields, as in substeps b and c.

e. If you want to modify the resulting Line Termination Attributes 
form, go to step 5. If not, go to step 6. 

5 Select the Line Termination Attribute to be modified. 

a. If the attribute has a check button, move to the required option 
and select it. Go to step 6.

b. If the attribute is a data entry field, select the Select All 
command in the field menu and type the required value.

6 Select OK to save the circuit definition.

Note: If a DX service in one NE is connected to a DX service in the 
other NE, terminate at least one side of the DX circuit before placing 
it in service.

7 Select OK to initiate the Add Circuit process.

8 Select OK to return to the Provisioning Manager main window.

- end -
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circuit

Step Action

1 From the Provisioning Manager main window, display the Operations 
menu and select Add Circuit.

2 Tab from field to field while filling in the information you have readily 
available.  

3 Continue entering data and selecting choices until all fields are filled 
in then select OK. 

4 Select OK to continue.

Note: If the Connection Manager tool is used to reassign a DS1 port 
during a Provisioning Manager session, you must restart the 
Provisioning Manager tool to reflect the change.

5 Specify the circuit details:

a. In the Circuit ID field, type a CLLI for the circuit if desired 
(maximum of 40 characters).

b. In the Loop Type field, type the loop type, or select it from the 
chooser menu.

Note:  Refer to the tables of values for loop types, service codes, and 
attributes in Line Card Provisioning Procedures, 323-3001-315, in 
Operations, Administration, and Provisioning, Volume 4B.

c. In the Service Code field, type the service code, or select it from 
the chooser menu.

If you want to modify the resulting Line Termination Attributes 
form, go to step 6. If not, go to step 7. 

6 Select the line termination attribute to be modified. 

a. If the attribute has a check button, move to the required option 
and select it.

b. If the attribute is a data entry field, select the Select All 
command in the field menu and type the required value.

—continued—
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Left even
Adding a DS1 tandem, DS1 tandem VT, TR-08, or TR-08 VT circuit (continued)

Step Action

7 Select OK to save the circuit definition.

Note: You may receive a warning, pointing out the location/type of a 
detected problem. The system will allow the provisioning, but you 
must correct the problem. 

8 Select OK to initiate the add circuit process. Select OK to return to 
the main window.

9 Repeat from step 2 for each circuit to be added.

- end -
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Step Action

1 From the Provisioning Manager window, display the Operations menu 
and select Detail Circuit.

2 In the Type field, select the channel type from the chooser menu: 
CDS line card, DS1 tandem channel, DS1 TR-08 channel, DS1 
tandem VT channel, or TR-08 VT channel

3 Specify the universal circuit being modified:

a. In the NE field, type the NE ID, NE name, or both, or select it from 
the chooser menu. 

b. In the CD Shelf field, type the CDS number of the shelf 
containing the circuit (1 to 7).

c. In the Slot field, type the slot number of the circuit, or select it 
from the chooser menu. Go to step 6.

4 Specify the DS1 tandem or DS1 TR-08 circuit being modified:

a. In the NE field, type the NE ID, NE name, or both, or select it from 
the chooser menu. 

b. In the Slot field, type the slot number of the circuit, or select it 
from the chooser menu. 

c. In the DS1 Port field, type the DS1 port carrying the circuit (1 to 
14), or select it from the chooser menu.

d. In the DS0 Channel field, type the DS0 channel carrying the 
circuit (1 to 24). Go to step 6.

5 Specify the DS1 tandem VT or TR-08 VT circuit being modified:

a. In the NE field, type the NE ID, NE name, or both, or select it from 
the chooser menu. 

b. In the VT group field, type the number of the VT group carrying 
the circuit (1 to 7), or select it from the chooser menu. 

—continued—

If you are modifying a Then do

CDS line card (universal circuit) step 3

DS1 tandem or DS1 TR-08 circuit step 4

DS1 tandem VT or TR-08 VT circuit step 5
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Modifying circuit details (continued)

Step Action

c. In the VT number field, type the VT number within the VT group 
(1 to 4), or select it from the chooser menu.

d. In the DS0 Channel field, type the DS0 channel (1 to 24) carrying 
the circuit.

6 Select OK to continue.

7 Change the circuit ID, loop type, or service code as required:

a. To change the circuit ID, select the Select all command in the 
Field menu, and type the new circuit ID.

b. To change the loop type, type the new loop type in the Loop Type 
field, or select it from the chooser menu.

c. To change the service code, type the new service code in the 
Service Code field, or select it from the chooser menu.

If you want to modify the resulting Line Termination Attributes 
form, go to step 8. If not, go to step 9.  

8 Select the Line Termination Attribute. 

a. If the attribute has a check button, move to the required option 
and select it.

b. If the attribute is a data entry field, select the Select All 
command in the field menu and type the required value.

9 Select OK to save the circuit definition.

Note: For a universal circuit, if a DX service in one NE is connected 
to a DX service in the other NE, be sure to terminate at least one side 
of the DX circuit before placing it in service.

—continued—

CAUTION
Risk of loss of service
For a DDS circuit, service is temporarily interrupted when 
error correction is turned ON or OFF. For a DDS 56 Kb/s or 
64 Kb/s circuit, service is interrupted when error correction is 
turned ON, until it is turned OFF again, IF a different service 
already occupies the next consecutive DS0 channel.
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Step Action

10 Select OK to initiate the modification process.

11 Repeat from step 2 for each circuit of the same type to be modified. 
Repeat from step 1 to modify circuit details for another type of circuit.

- end -
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Perform this procedure to delete any unnecessary circuits after you have 
bulk-provisioned a CDS. 

Step Action

1 From the Provisioning Manager window, display the Operations menu 
and select Delete Circuit.

2 Specify the circuit:
a. In the Type field, select the circuit type from the chooser menu.
b. In the NE field, type the NE ID, NE name, or both, or select it from 

the chooser menu. 

3 Specify the universal circuit to be deleted:
a. In the CD Shelf field, type the CDS number of the shelf that 

contains the circuit (1 to 7). 
b. In the Slot field, type the slot number for the circuit (1 to 96). 

Go to step 6.
4 Specify the DS1 tandem or DS1 TR-08 circuit:

a. In the DS1 Slot field, type the DS1/VT mapper slot number 
carrying the circuit, or select it from the chooser menu. 

b. In the DS1 Port field, type the DS1 port (1 to 14), or select it from 
the chooser menu. 

c. In the DS0 Channel field, type the DS0 channel (1 to 24) carrying 
the circuit. Go to step 6.

5 Specify the DS1 tandem VT or DS1 TR-08 VT circuit to be deleted:
a. In the VT group field, type the number of the VT group, or select 

it from the chooser menu. 

b. In the VT number field, type the VT number within the VT group, 
or select it from the chooser menu. 

c. In the DS0 Channel field, type the DS0 channel (1 to 24) carrying 
the circuit.

—continued—

If you are deleting a Then do

CDS line card (universal circuit) step 3

DS1 tandem or DS1 TR-08 circuit step 4

DS1 tandem VT or TR-08 VT circuit step 5
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Step Action

6 Select OK to conclude the circuit definition. Select OK to initiate the 
deletion process.

7 Repeat from step 2 for each circuit of the same type to be deleted. 
Repeat from step 1 to delete a circuit of another type. 

- end -

Modifying log and alarm settings
This task is performed at the OPC. For a summary of the keystrokes required 
to navigate in an OPC screen, see “Using the OPC UI” on page 2.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Line Card Provisioning Procedures, 
323-3001-315, in Operations, Administration, and Provisioning, Volume 4B. 

Setting service-level logs and alarms

Step Action

1 From the Alarm Provisioning Manager main window, display the line 
card alarm provisioning dialog. 

2 In the Scope of Provisioning field, select Service level from the 
chooser menu.

3 Select OK to confirm the selection.

To view the current setting of an NE, go to step 4.
To clear the service-level log/alarm setting list, go to step 5.
To set a service-level trouble event for one NE, go to step 6.

—continued—
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Left even
Setting service-level logs and alarms

Step Action

4 View the current setting:

a. In the Service level provisioning screen, select the required NE.

b. Select Display Setting, then select OK to confirm the selection.

c. The log/alarm setting list appears, displaying the current setting 
associated with each service type. Use the tab and arrow keys 
to view the settings for the selected NE. 
Go to step 3.

5 Clear the service-level log/alarm setting list:

a. In the Service level provisioning screen, select Deselect All from 
the chooser menu.

b. Go to step 3.

6 Set a service-level trouble event for an NE:

a. In the Service level provisioning screen, select the NE for which 
you want to set a service-level trouble event.

b. In the Display Setting field, select the type of service.

c. From the chooser menu, select one of these options:

Set as default, Set as Log, or Set as Alarm

If you select Set as Alarm, use the chooser menu to specify the 
severity level for the alarm.

7 Select Apply to transfer the alarm information to the selected NE.

8 Select OK to confirm the transfer.

9 Select Cancel twice to return to the Alarm Provisioning Manager 
window.

- end -
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Step Action

1 From the Alarm Provisioning Manager main window, display the line 
card alarm provisioning dialog. 

2 In the Scope of Provisioning field, select Line card from the chooser 
menu.

3 Select OK.

4 Specify the location in the Line card level LC alarm provisioning 
screen:

a. In the NE ID field, select the NE ID from the chooser menu.

b. In the CD Shelf field, select the CD shelf number from the 
chooser menu. 

c. In the Slot number field, enter the number of the slot.

5 If you want to view the current settings, select Current setting.

6 In the Log/Alarm field, select one of these options from the chooser 
menu:

Reset to service-level, Log, or Alarm

If you select Set as Alarm, use the chooser menu to specify the 
severity level for the alarm.

7 Select Apply to transfer the information to the selected NE.

8 Select OK to confirm the transfer.

9 Select Cancel twice to return to the Alarm Provisioning Manager 
window.

- end -
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The LC Equip Alarm Provisioning screen is accessible only if a line card 
reports events as alarms, not as logs.

Step Action

1 From the NE status screen, display the LC Equip Alarm Provisioning 
screen:

eq lc <cds #> <slot #>; almprov ↵

where
<cds #> 1 to 7 (copper distribution shelf number)
<slot #> 1 to 96 (line card slot number)

Note 1: To modify alarm reporting on a multi-slot line, display the 
master slot for the service, not the slave slot.

Note 2: For AccessNode Express, display the LC Equip Alarm 
Provisioning screen by entering:

eq anxlc <vm #> <slot #> ↵

almprov ↵

where
<vm #> 1 to 28 (ANX shelf number)
<slot #> 1 to 48 (line card slot number)

2 Set individual alarm points to on or off:

editstat <alarm point #> <status> ↵

y↵

where
<alarm point #> Line card fail alarm: 1

Line card missing alarm: 2 
<status> on or off

Repeat this step to modify alarm generation for other alarm points on 
this line card.

—continued—
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Step Action

3 To change alarm settings on another line card:

select <cds #> <slot #> ↵

Repeat step 2 to modify alarm generation for the line card you 
selected.

- end -
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This procedure enables or disables generation of the loss of synchronization 
(LOS) alarm for all ISDN circuits in the NE.

Step Action

1 Log in to the NE user interface at the RFT.

2 Invoke the SMCSTMCI command interpreter:

SMCSTMCI ↵

3 View the current setting:

view_isdn_los_status ↵

4 Change the current setting:

change_isdn_los_status <status> ↵

y ↵

where
<status> enabled or disabled

Note: If you use this tool to disable ISDN alarms, it does not clear 
existing ISDN NT1 alarms. This tool disables new ISDN alarms once 
the NT1 is placed on line. 

5 Leave the SMCSTMCI command interpreter:

quit ↵
- end -

If you want to Then go to

view the ISDN LOS Event Notification setting step 3

change the ISDN LOS Event Notification setting step 4
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Some of these tasks are performed at the OPC. For a summary of the 
keystrokes required to navigate in an OPC screen, see “Using the OPC UI” on 
page 2.

For additional information on any procedure in this section, refer to the 
corresponding detailed procedure in Data Administration Procedures, 
323-3001-304, in Operations, Administration, and Provisioning, Volume 4A. 

Performing a manual NE database backup

Step Action

1 From the NE Status screen, display the equipment shelf screen and 
back up the NE database to the OPC:

eq sh; backupdb ↵
y ↵

The backup process can take up to five minutes.

2 Check the logs buffer to confirm the completion of the backup:

logutil ↵

open FWDB ↵

The FWDB logs show the status of the backup. An FWDB300-series 
log indicates if there is a problem with the backup.An 
FWDB400-series log indicates a successful backup. 

Refer to Log Report Manual, 323-3001-840, in Maintenance, 
Volume 5B. 

3 Quit Logutil:

quit ↵
- end -



88   Managing NE and OPC databases

AccessNode   P0887750   Issue 1.0     

Left even Saving OPC data to tape

Before starting, insert the backup tape in the local OPC tape drive. The Save 
operation can take up to 12 minutes.

Step Action

   

1 Select the OPC Save and Restore tool from the OPC Admin toolset. 

2 In the OPC Save and Restore main window, select Display tape 
details.

3 In the resulting Tape Details dialog, verify that the correct tape is 
inserted, then select Done.

4 In the OPC Save and Restore main window, select Save OPC data 
to tape, then select Yes to confirm your request.

5 Do one of the following:

a. If the tape is blank, select Done to continue the save operation. 
Go to step 6.

b. If you are overwriting existing data, select OK. Go to step 6.

c. If you want to cancel the operation, select Cancel, then select 
OK to confirm your cancellation request. 

6 Select Done to close the completion dialog.

- end -

CAUTION
Risk of damaging circuit packs
Electrostatic discharge can damage electrostatic-sensitive devices. Always 
ground yourself before handling tapes.
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Use this procedure to start, define, or discontinue a scheduled backup 
operation.   

Step Action

   

1 Select the OPC Save and Restore tool from the OPC Admin toolset. 

Note: The default state for the scheduler is disabled.

2 In the OPC Save and Restore window, select Enable scheduler then 
select Done.

3 Select Edit schedule.

4 Select Default then go to step 7. 

—continued—

CAUTION
Risk of damaging circuit packs
Electrostatic discharge can damage electrostatic-sensitive devices. Always 
ground yourself before handling tapes.

If you want to Then go to

begin a scheduled backup step 2

edit an existing backup schedule step 3

discontinue a currently scheduled backup step 8

If you want to use Then go to

the default schedule (04:00 starting tomorrow) step 4

your own schedule step 5
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Scheduling an OPC backup (continued)

Step Action

5 Define the frequency of the backups.

a. In the Run every field, enter how often you want the backups to 
occur. 

b. Select the Time button (Hours or Days) you want. 

6 In the Next Run fields:

a. Enter the time when you want the backups to occur, using the 
format, hh:mm, where hh is the hour (based on a 24-hour clock) 
and mm is the minutes.

b. Enter the date when you want the next backup to occur. The only 
valid dates are today’s date and tomorrow’s date. You can either 
enter the date directly into the field, using the format mm/dd/yyyy, 
where mm is the month, dd is the day and yyyy is the year. 

7 Select OK.

8 Discontinue the scheduled backups by selecting Disable scheduler.

- end -

If you select Then the valid range is

Hour(s) 2 to 23

Day(s) 1 to 99
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